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Product notice

This guide describes features that are
common to most models. Some features may
not be available on your computer.

Not all features are available on all editions
of Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take
full advantage of Windows 8 functionality.
See http://www.microsoft.com for details.

This computer may require upgraded and/
or separately purchased hardware and/or a
DVD drive to install the Windows 7 software
and take full advantage of Windows 7
functionality. See
http://windows.microsoft.com/en-us
windows7/get-know-windows-7 for defails.



http://www.microsoft.com
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7

Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product features

Overview

The HP ProOne 400 G1 All-in-One offers the following features:

Integrated All-in-One form factor
54.6-cm (21.5-inch) diagonal widescreen WLED backlit anti-glare LCD (1920 x 1080)
Optical touch screen

Adjustable tilt

Removable panel on the back of the computer allows users or technicians to easily and efficiently
service the PC

VESA mounting holes (100 mm x 100 mm)
4th generation Intel® Core™ processors

Up to 2 TB Hard Drive, 180 GB Solid State Drive, 256 GB Self-encrypting Solid State Drive, 500
GB Self-encrypting Drive, or 1 TB Solid State Hard Drive

Optional Tray-load HP SuperMulti DVD+/-RW SATA Optical Disc Drive, DVD-ROM Disc Drive, or
Slim BDXL Blu-ray Writer

Intel H81 Express chipset

Overview



e Two SODIMM slots with up to 16 GB of DDR3 SDRAM memory and dual channel memory support
e Intfel integrated graphics
o DisplayPort video out (with audio) for second display support
e  Serial port
e DP audio, DP to VGA/DVI/HDMI dongle support
e |Integrated Realtek RTL8151GH-CG GbE Ethernet Controller
e  Wireless connectivity (optional):
o Intel Dual Band Wireless-N 7260, 802.11 a/b/g/n
> WILAN and Bluetooth Combo Card, 802.11 a/b/g/n Bluetooth® 4.0
e  Optional integrated webcam and dual microphone array
e  Premium stereo speakers
e  Optional 5-in-1 media card reader
e 6 USB ports: 1 USB 3.0, 1 USB 3.0 (fast-charging), 4 USB 2.0
e  Choice of wired or wireless keyboard and mouse
o Wired USB keyboard and mouse
o HP USB-PS/2 washable keyboard and mouse
o Wireless keyboard and mouse
e Windows® 7 Professional 32-bit or 64-bit or Windows® 8.1 Professional 64-bit operating system
e  Up to 89-percent energy-efficient external power supply

e ENERGY STAR® qualified, EPEAT® Gold registered

For more information, go to http://www.hp.com/go/productbulletin and search for your specific
computer model to find the model-specific QuickSpecs.

2 Chapter 1 Product features
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Front components
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Component Component
1 Dual microphone array (optional) 4 Power button
2 Webcam activity LED (with optional webcam) 5 High-performance stereo speakers

3 Webcam (optional)

Front components
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Side components
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Component Component

1 Tray-load optical disc drive 6 HP 5-in-1 media card reader (optional)
2 Optical disc drive eject button 7 USB 3.0 port

3 Optical disc drive activity LED 8 USB 3.0 port, fast-charging

4 Hard disc drive activity LED 9 Microphone jack

5 HP 5-in-1 medial card reader (optional) LED 10 Headphone jack

Chapter 1

Product features



Rear components

Component

Component

1

Access panel

7

Power supply connector

2 Access panel security screw (storage position) 8 Power supply DC-in activity LED
3 Security screw hole (locking position) 9 RJ-45 Gigabit Ethernet port

4 DisplayPort port 10 (4) USB 2.0 ports

5 Serial port 11 Stereo audio line out

6 Cable lock slot

Rear components



Adjusting the stand

This stand allows you to tilt the computer backward from 10 degrees to 25 degrees to set it fo a
comfortable angle.

6 Chapter 1 Product features



Serial number location

The computer has a unique serial number and a product ID number that are located on the exterior of
the computer. Keep these numbers available for use when contacting customer service for assistance.

Serial number location

7
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2 Display options

Adjusting the audio signal

e  There is no hardware volume control button on the HP ProOne 400 G1 AiO. (However, some
keyboards do have volume function buttons.)

e  Volume can be adjusted with the operating system (OS) master control or the software (SW) audio
player control.

e The OS master control and SW audio player control are independent. However, they are both
simultaneously active and affect the overall volume of the audio signal.

e If the audio signal is not audible, check the OS master control and SW audio player control to be
sure that neither is set too low.

Adjusting display brightness

The HP ProOne 400 G1 AiO backlight brightness settings control the overall brightness of the internal
display panel only.

Windows 7 and Windows 8 each offer two methods for controlling the backlight brightness of the
internal display panel. These two options adjust the backlight brightness from 100% down to 30% of
the full backlight brightness.

Windows 7

1. Select Control Panel > Power Options.

2. Move the screen brightness slider at the bottom of the window to make adjustments.
—or—

1. Click Start > Programs > Productivity and Tools > HP My Display.

2. Select Adjust.

3. Move the slider to make adjustments.

4. At the bottom of the window, click Apply or OK to save the changes.

Chapter 2 Display options



Windows 8

1. Point fo the upper-right of the Start screen to display the Charms menu.
2. Click Settings.

3. In the lower corner of the right panel, click Brightness.

4. Move the slider to make adjustments.

—or —

1. From the desktop window, point fo the task bar at the lower edge of the screen.

2. Click the Show hidden icons arrow then click the HP My Display icon.
3. Select Adjust.
4. Move the slider to make adjustments.

5. At the bottom of the window, click Apply or OK to save the changes.

Adjusting display brightness

9



3 Activating and Customizing the
Software

@NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in
Windows 7

If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.

/\ CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.

2¥»NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows operating system

The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.

/\ CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

E/%"NOTE: If the computer shipped with more than one operating system language on the hard drive, the
activation process could take up to 60 minutes.

10 Chapter 3 Activating and Customizing the Software



Downloading Windows 7 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions
on the screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3. Run Windows Update monthly thereafter.

Installing or upgrading device drivers

When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\ 1386, or use
the Browse button in the dialog box to locate the 1386 folder. This action points the operating system
to the appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in
Windows 8

Additional information is available in online help after you activate the operating system.

2 NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows Operating System
The first time you turn on the computer, the operating system is set up and activated automatically. This

process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

Activating and customizing the software in Windows 8 11
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We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You can
also register your computer with HP using the Register with HP app on the Start screen.

/\ CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE

PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.
1. Point to the upper-right or lower-right corner of the Start screen to display the charms.
2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the monitor display

12

You can customize display settings for Windows 8 separately for the Start screen and the Desktop.
To customize the Start screen:

1. Point o the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings.

3. Click Personalize to change the display settings.

To customize the Desktop:

1. Click the Desktop app on the Start screen.

2. Rightclick on the desktop, and then click Personalize to change display settings.

Chapter 3 Activating and Customizing the Software



4 lllustrated parts catalog

E%?NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

System unit

Item  Description Spare part number

(1) Rear cover 764957-001

(2) Front bezel

For use in models with a webcam 764958-001

System unit 13
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Item Description Spare part number
For use in models without a webcam 76499-001

(3) Stand 763209001

(4) System board (includes replacement thermal material)
For use in non-Windows 8 models 737340001
For use in models with Windows 8 Standard 737340-501
For use in models with Windows 8 Professional 737340-601
Display panel (includes touch controller board and backlight cable) 763203-001
Power supply, 120W 740243-001
Memory modules, PC3-12800, 1666-MHz (not illustrated)
8-GB 689374001
4-GB 689373001
2-GB 689372-001
Processors (include replacement thermal material; not illustrated)
Intel Core i7 4770T processor, 2.5 GHz, 8-MB L3 cache, 45W 758446-001
Intel Core i7 4765T processor, 2.0 GHz, 8-MB L3 cache, 35W 754000-001
Intel Core i5 4670T processor, 2.3 GHz, 6-MB L3 cache, 45W 753999-001
Intel Core i5 4570T processor, 2.9 GHz, 4-MB L3 cache, 35W 753998-001
Intel Core i3 4330T processor, 3.0 GHz, 4-MB L3 cache, 35W 753995-001
Intel Core i3 4130T processor, 2.9 GHz, 3-MB L3 cache, 35W 757416-001
Intel Pentium G3420T processor, 2.7 GHz, 3-MB L3 cache, 35W 763217-001
Intel Pentium G3220T processor, 2.6 GHz, 3-MB L3 cache, 35W 763216-001
Intel Celeron G1820T processor, 2.4 GHz, 2-MB L3 cache, 35W 753994-001
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Misc parts

Item  Description Spare part number
(1) Heat sink (includes replacement thermal material) 763213-001
(2) Hard drive connector 763122-001
(3) Optical drive connector 763121-001
(4) Fan 763214-001
(5) Foot cover (includes left and right covers) 764961-001
(6) Speakers 763212-001
Card reader cover (for models without a media card reader) 764960-001
Foot cover (includes left and right covers) 764961-001
HP Ultraslim Keyed Cable Lock 703372-001

Mouse (not illustrated)

USB, optical 537749001
USB, laser 674318001
Washable 724795001
Adapters

Display Port (DP) to DVI 662723-001
Display Port (DP) o HDMI 617450001

Misc parts 15



Item Description Spare part number
Display Port (DP) to VGA 632484-001
Optical drive bezel 763207-001
Hard drive grommet 763210001
Rubber feet 763211-001
Boards

TRONLERRREREENE

Item Description Spare part number
(1) Converter board 763205-001
(2) Touch sensor board (included with display panel kit, 763203-001) not spared separately
(3) Power button board (includes insulator) 764962001
(4) WLAN modules:
HP WLAN 802.11 a/b/g/n + Bluetooth 4.0 697316-001
HP WLAN 802.11 a/b/g/n, 2x2 767424-001
Webcam 763215-001
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Keyboards

Description Spare part number
Keyboards

USB, Smartcard, CCID 70167 1-xx1

uss 724720-xx1

PS2, washable 700510-xx1

Wireless keyboard, mouse, and dongle 730323-xx]1

Country codes:

Arabic -17x Japanese -29x
French Arabic -DEx Latin American Spanish -16x
BHCSY -B4x Norwegian -09x
Belgian -18x Chinese -AAxX
Brazilian Portuguese -20x Portuguese -13x
Bulgaria -26x Romanian 27x
Czech and Slovakian -22x Russian -25x
-CGx
Danish -08x Slovenian -23x
French -05x South Korean -KDx
French Canadian -12x Spanish -07x
German -04x Swedish -10x
Greek -15x Swiss -11x
Hebrew -BBx Taiwanese -ABx
Hungarian 21x Thai -28x
Indian -Déx Turkish -14x
International English -L3x United States -01x
ltalian -06x United Kingdom -03x

Keyboards 17



Cables

Description Spare part number
Backlight cable 763129-001
Converter board cable 763123001

Display (LVDS) cable 763127-001

Power button board cable 763126-001
Webcam cable 763128-001

Optical drive connector and cables 763121-001

Hard drive connector and cables 763122001

Touch control cable 763124-001
Antenna kit 763125-001
DisplayPort cable 487562001

Drives
Description Spare part number

Optical drives:

Blu-ray writer (BD-RE) drive (includes bezel) 719157-001
SuperMulti DVD+RW drive (includes bezel) 657958-001
DVD-ROM drive (includes bezel) 608394-001
Optical drive bezel 763207-001

Hard drives/solid-state drives:

2 TB, 7200 rpm hard drive 616608-001
1 TB, 7200 rpm hard drive 621418-001
1 TB, 7200 rpm, hard drive, 2.5-inch, hybrid SSD 724937-001
500 GB, 7200 rpm hard drive, 3.5-inch 621421-001
500 GB, 7200 rpm hard drive, 2.5-inch 686217-001
500 GB, 7200 rpm hard drive, 2.5-inch, self-encrypting (SED) 696442-001
500 GB, 7200 rpm, hard drive, 2.5-inch, hybrid SSD 724938-001
500 GB, 7200 rpm hard drive, 2.5-inch, SATA-6G 754078-001
320 GB, 7200 rpm hard drive, 2.5-inch 639135-001
320 GB, 7200 rpm hard drive, 2.5-inch, SATA-6G 754077-001
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Description Spare part number
256 GB solid-state drive (SSD), self-encrypting (SED) 746141-001
180 GB solid-state drive (SSD), SATA 6.0, MLC 754076-001
128 GB solid-state drive (SSD), Self-encrypting Drive (SED), SATA 6.0 746140-001
120 GB solid-state drive (SSD), SATA 6.0, MLC 756459-001
Hard drive removable frame carrier 732060-001

Sequential Part Number Listing

Spare part  Description

number

487562-001  DisplayPort cable

537749001  Mouse, USB, optical

608394-001  DVD-ROM drive (includes bezel)

616608-001 2 TB, 7200 rpm hard drive

617450-001  Display Port (DP) to HDMI

621418001 1 TB, 7200 rpm hard drive

621421-001 500 GB, 7200 rpm hard drive, 3.5-inch
632484-001  Display Port (DP) to VGA

639135-001 320 GB, 7200 rpm hard drive, 2.5-inch
657958-001  SuperMulti DVDRW drive (includes bezel)
662723-001  Display Port (DP) to DVI

674318-001  Mouse, USB, laser

686217001 500 GB, 7200 rpm hard drive, 2.5-inch
689372-001  2-GB memory module, PC3-12800, 1666-MHz
689373-001  4-GB memory module, PC3-12800, 1666-MHz
689374-001  8-GB memory module, PC3-12800, 1666-MHz
696442001 500 GB, 7200 rpm hard drive, 2.5-inch, self-encrypting (SED)
697316001  HP WLAN 802.11 a/b/g/n + Bluetooth 4.0
700510-xx1 Keyboard, PS2, washable

70167 1-xx1 Keyboard, USB, Smartcard, CCID
703372-001  HP Ultraslim Keyed Cable Lock

719157-001  Blu-ray writer (BD-RE) drive (includes bezel)

Sequential Part Number Listing
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Spare part  Description
number

724720xx1  Keyboard, USB

724795-001  Mouse, washable

724937-001 1 TB, 7200 rpm, hard drive, 2.5-inch, hybrid SSD

724938001 500 GB, 7200 rpm, hard drive, 2.5-inch, hybrid SSD

730323-xx1 Keyboard, wireless keyboard, mouse, and dongle

732060-001  Hard drive removable frame carrier

737340001  System board for use in non-Windows 8 models (includes replacement thermal material)

737340-501  System board for use in models with Windows 8 Standard (includes replacement thermal material)

737340-601  System board for use in models with Windows 8 Professional (includes thermal material)

740243-001  Power supply, external, 120W

746140001 128 GB solid-state drive (SSD), Self-encrypting Drive (SED), SATA 6.0

746141-001 256 GB solid-state drive (SSD), self-encrypting (SED)

753994-001  Intel Celeron G1820T processor, 2.4 GHz, 2-MB L3 cache, 35W

753995-001 Intel Core i3 4330T processor, 3.0 GHz, 4-MB L3 cache, 35W

753998-001 Intel Core i5 4570T processor, 2.9 GHz, 4-MB L3 cache, 35W

753999-001 Intel Core i5 4670T processor, 2.3 GHz, 6-MB L3 cache, 45W

754000-001  Intel Core i7 4765T processor, 2.0 GHz, 8-MB L3 cache, 35W

754076001 180 GB solid-state drive (SSD), SATA 6.0, MLC

754077-001 320 GB, 7200 rpm hard drive, 2.5-inch, SATA-6G

754078001 500 GB, 7200 rpm hard drive, 2.5-inch, SATA-6G

756459-001 120 GB solid-state drive (SSD), SATA 6.0, MLC

757416-001 Intel Core i3 4130T processor, 2.9 GHz, 3-MB L3 cache, 35W

758446-001 Intel Core i7 4770T processor, 2.5 GHz, 8-MB L3 cache, 45W

763121-001  Optical drive cable

763122-001  Hard drive cable

763123-001  Converter board cable

763124-001  Touch control cable

763125-001  Antenna kit

763126-001  Power button board cable

763127001  Display (LVDS) cable

763128-001  Webcam cable

763129001  Backlight cable

20 Chapter 4 lllustrated parts catalog



Spare part  Description

number

763203001  Display panel (includes touch controller board and backlight cable)
763205001  Converter board

763207-001  Optical drive bezel

763209-001  Stand

763210001  Hard drive grommet

763211001  Rubber feet

763212-001  Speaker

763213-001  Heat sink

763215001  Webcam

763216-001 Intel Pentium G3220T processor, 2.6 GHz, 3-MB L3 cache, 35W
763217-001 Intel Pentium G3420T processor, 2.7 GHz, 3-MB L3 cache, 35W
764957-001  Rear cover

764958-001  Front bezel for use in models with a webcam

764959001  Front bezel for use in models without a webcam

764960-001  Card reader cover (for models without a media card reader)
764961-001  Foot cover (includes left and right covers)

764962-001  Power button board (includes insulator)

767424-001 HP WLAN 802.11 a/b/g/n, 2x2

Sequential Part Number Listing
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5 Rovutine care, SATA drive

guidelines, and disassembly
preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

/\ CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer fo prevent system board or component damage.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.
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Generating static

The following table shows that:

o Different activities generate different amounts of static electricity.
e Static electricity increases as humidity decreases.
Relative Humidity
Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000V
Removing DIPs from plastic tube 400 V 700V 2,000 V
Removing DIPs from vinyl tray 2,000 V 4,000V 11,500 V
Removing DIPs from Styrofoam 3,500 V 5,000 V 14,500 V
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

[y NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their container.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Electrostatic discharge information

23



Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

e  Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

e Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one-megohm + 10% resistance between the operator and

ground.
Static Shielding Protection Levels
Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the work area

To prevent static damage at the work areq, use the following precautions:

e  Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

e  Use static-dissipative mats, foot straps, or air ionizers to give added protection.

e Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at staticfree work areas.

e Turn off power and input signals before inserting and removing connectors or test equipment.
e  Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

o Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

e Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
e Antistatic tape
e Antistatic smocks, aprons, or sleeve protectors

e  Conductive bins and other assembly or soldering aids
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Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opagque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

Keep liquids away from the computer and keyboard.
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e  Never cover the ventilation slots on the monitor with any type of material.

e Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.

3
4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.

6

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General cleaning safety precautions on page 26 before cleaning the
computer.

To clean the computer case, follow the procedures described below:
e To remove light stains or dirt, use plain water with a clean, lintfree cloth or swab.

e  For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

e  For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

e  Atfter cleaning, always wipe the unit with a clean, lintfree cloth.
e  Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 26 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 26.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions
on page 26 before following these procedures:
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/\ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

e Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e Canned, pressurized air may be used to clean debris from under the keys. Caution should be used
as too much air pressure can dislodge lubricants applied under the wide keys.

e If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.

/\ CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 26.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

e  Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 26.

Service considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and software Requirements

To service the computer, you need the following:

e Torx T-15 screwdriver

e Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
o  Flatbladed screwdriver (may sometimes be used in place of the Torx screwdriver)

e  Phillips #2 screwdriver
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e Diagnostics software

e  Tamper-resistant T-15 wrench

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the
part that was removed, then returned to their proper locations.

/\ CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced.

/\ CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

e If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

e  Avoid dropping drives from any height onto any surface.

e If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

e  Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic damage,
refer to Electrostatic discharge information on page 22

e Do not use excessive force when inserting a drive.

e  Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.
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Lithium coin cell battery

The battery that comes with the computer provides power to the realtime clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.

/A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C). Do not attempt to recharge the
battery.

E’%NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.

SATA hard drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 3.3V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 3.0Gb/s
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SATA hard drive cables

SATA data cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Cable management

Always follow good cable management practices when working inside the computer.
e Keep cables away from major heat sources like the heat sink.

e Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

e Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

e  When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

e  Some flat ribbon cables come prefolded. Never change the folds on these cables.
e Do not bend any cable sharply. A sharp bend can break the internal wires.

e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

e Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.
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6 Removal and Replacement
Procedures All-in One (AlO) Chassis

The following sections provide information about disassembling various components of the computer.

2»NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Preparing to disassemble the computer

To avoid injury and equipment damage, always complete the following steps in order, when opening
the HP Pro All-in-One.

1.
2.

Remove all media from the computer.
Shut down the computer.

After the system has completely shut down, disconnect the power adapter from the back of the
computer.

Disconnect all other attached cables from the back of the computer.

If the height adjustable/recline stand is installed, before laying the computer down for service,
position the computer vertically by grasping the sides of the display, and then raise the display to
the highest position.

Place the computer face down on a soft flat surface. HP recommends that you set down a blanket,
towel, or other soft cloth to protect the screen surface from scratches or other damage.

/\ WARNING! If the height adjustable/recline stand is installed, do not lay the computer down

with the sliding stand in the low position. The stand may suddenly release which could cause
damage to equipment or injury.

/\ WARNING! Beware of sharp edges inside the chassis.

Preparing to disassemble the computer
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Installing an rear cover security screw

You may prevent access fo internal components by securing the rear cover. Remove the T15 tamper-
resistant Torx security screw from the storage position in the rear of the computer and screw it into the
security screw hole (locking position) to prevent removal of the rear cover.

32 Chapter 6 Removal and Replacement Procedures Allin One (AIO) Chassis



Synchronizing the optional wireless keyboard and
mouse

The optional wireless keyboard and mouse are easy to set up. Just remove the battery tabs on both the
keyboard and the mouse to activate the preinstalled batteries.

E%?NOTE: For better mouse battery life and performance, avoid using your mouse on a dark or high-
gloss surface, and turn mouse power off when not in use.

To synchronize the wireless keyboard and mouse:

1. Make sure the keyboard and mouse are next to the computer, within 30 cm (1 foot) and away
from interference from other devices.

2. Turn on the computer.
3. Make sure the Power switch on the bottom of the mouse is in the On position.

4. Insert the wireless receiver into a USB port on the computer.

5. Press and hold the Connect button on the wireless receiver for five seconds until the blue activity
LED begins blinking.

%/?’NOTE: When the blue activity LED begins blinking, you have 30 seconds to synchronize the
mouse with the wireless receiver.

6. Press and release the Connect button on the bottom of the mouse. The blue activity LED from the
wireless receiver turns off when synchronization is complete.

@NOTE: If the Connect button on the bottom of the mouse is pressed again, the synchronization
of the wireless receiver and the mouse will be broken. Turn the mouse off, then on again to restore
the synchronization.

E%?NOTE: If the procedure does not work, remove and then reinsert the wireless keyboard and mouse
receiver from the back of the computer and then synchronize the keyboard and mouse again. If
synchronization still does not work, remove and replace the batteries.
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Rear cover

Description Spare part number

Rear cover 764957-001

The computer has one main rear cover that allows access to internal components.
To remove the rear cover:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Lloosen the two captive screws at the bottom of the computer (1) to release the bottom edge of the
rear cover.

3. Rotate the bottom edge of the rear cover up (2), and then lift the rear cover off of the computer (3).

To replace the rear cover, reverse the removal procedures.
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Stand

Description Spare part number

Stand 763209-001

The computer stand is secured to a VESA mount inside the computer chassis. You can remove the stand
and install the computer on a wall, monitor arm, or other mounting fixture.

To remove the stand:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

3. Remove the three screws (1) securing the stand to the rear cover, and then remove the stand (2).

By NOTE:  Save the screws together with the stand in case they are needed in the future.
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4. Foot covers are stored on the inside of the rear cover.

After you remove the stand, install the covers in the stand mount gaps.

E/?NOTE: Only the left cover is shown. Be sure to install the right cover as well.

5. If you need to replace the rear cover with the stand removed (to prepare the computer for VESA
mounting), set the top edge of the rear cover down on the top edge of the computer chassis (1).
Be sure to align the hooks on the underside of the top edge of the rear cover with the top edge of
the computer.
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6. Rotate the bottom edge of the rear cover down (2) and press it firmly onto the chassis until it locks
into place.

7. Tighten the captive screws (3) to secure the rear cover in place.

The computer is now ready to be mounted to a wall, monitor arm, or other mounting fixture.

Replacing drives

Description Spare part number

Optical drives:

Blu-ray writer (BD-RE) drive (includes bezel) 719157-001
SuperMulti DVD£RW drive (includes bezel) 657958001
DVD-ROM drive (includes bezel) 608394-001
Optical drive bezel 763207-001

Hard drives/solid-state drives:

2 TB, 7200 rpm hard drive 616608-001
1 TB, 7200 rpm hard drive 621418-001
1 TB, 7200 rpm, hard drive, 2.5-inch, hybrid SSD 724937-001
500 GB, 7200 rpm hard drive, 3.5-inch 621421-001
500 GB, 7200 rpm hard drive, 2.5-inch 686217-001
500 GB, 7200 rpm hard drive, 2.5-inch, self-encrypting (SED) 696442001
500 GB, 7200 rpm, hard drive, 2.5-inch, hybrid SSD 724938-001
500 GB, 7200 rpm hard drive, 2.5-inch, SATA-6G 754078-001
320 GB, 7200 rpm hard drive, 2.5-inch 639135-001
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Description Spare part number

320 GB, 7200 rpm hard drive, 2.5-inch, SATA-6G 754077-001
256 GB solid-state drive (SSD), self-encrypting (SED) 746141-001
180 GB solid-state drive (SSD), SATA 6.0, MLC 754076-001
128 GB solid-state drive (SSD), Self-encrypting Drive (SED), SATA 6.0 746140-001
120 GB solid-state drive (SSD), SATA 6.0, MLC 756459-001
Hard drive removable frame carrier 732060001

Replacing a hard drive

The hard drive is located behind the rear cover on the lower left side of the computer (when viewed
from behind). The drive is housed in a removable cage.

Any one of the following may be installed in the computer:
e  One 3.5-inch hard drive

e  One 2.5-inch solid state drive (SSD), self-encrypting drive (SED), or solid state hybrid drive (SSHD)

E%?NOTE: The 2.5-inch drive option kit from HP also contains the adapter required to install this
drive.

e Removing a hard drive

e |Installing a hard drive

Removing a hard drive

e Removing a 3.5-inch hard drive

e Removing a 2.5-inch solid state drive (SSD), self-encrypting drive (SED), or solid state hybrid drive

(SSHD)

Removing a 3.5-inch hard drive

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).
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2. Remove the rear cover (see Rear cover on page 34).

The hard drive cage can now be seen in the lower left side of the chassis.

3. Lloosen the captive screw securing the hard drive cage in the chassis (1).

4. Slide the hard drive cage left, and then lift it out of the chassis (2).

5. Remove the four mounting screws (1) securing the 3.5-inch hard drive in the hard drive cage. Be
sure fo keep the screws together with the blue rubber grommets to use to install a replacement

drive.

Replacing drives
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6. Slide the 3.5-inch hard drive out of the hard drive cage (2).

For instructions on installing a hard drive, see Installing a hard drive on page 43.
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Removing a 2.5-inch solid state drive (SSD), self-encrypting drive (SED), or solid state hybrid
drive (SSHD)

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

The hard drive cage can now be seen in the lower left side of the chassis.

3. Lloosen the captive screw securing the hard drive cage in the chassis (1).

4. Slide the hard drive cage left, and then lift it out of the chassis (2).

5. Remove the four mounting screws (1) securing the 2.5-inch drive adapter in the hard drive cage.
Be sure to keep the screws together with the blue rubber grommets to use to install a replacement
drive.

Replacing drives
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6. Slide the 2.5-inch drive adapter out of the hard drive cage (2).

7. Remove the four screws (1) securing the 2.5-inch drive in the drive adapter. Be sure to keep the
screws to use to install a replacement drive.

8. Slide the 2.5-inch hard drive out of the drive adapter (2).

‘ ._Huw}\// 1
P

" / n<
3 ;/\0/ ¥y,

For instructions on installing a hard drive, see Installing a hard drive on page 43.
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Installing a hard drive

e |Installing a 3.5-inch hard drive

e Installing a 2.5-inch solid state drive (SSD), self-encrypting drive (SED), or solid state hybrid drive

(SSHD)

Installing a 3.5-inch hard drive

1. Slide the new 3.5-inch hard drive into the hard drive cage (1). Be sure that the hard drive
connector is facing up at the open end of the drive.

2. Screw the four mounting screws through the sides of the hard drive cage into the 3.5-inch hard
drive (2). Be sure to keep the blue rubber grommets behind each screw.

3.  With the 3.5-inch hard drive connector facing toward the center of the chassis, place the hard
drive cage into the chassis and slide it toward the center until it snaps into place (1).

4. Tighten the captive screw (2) to secure the hard drive cage in the chassis.

Replacing drives
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Installing a 2.5-inch solid state drive (SSD), self-encrypting drive (SED), or solid state hybrid
drive (SSHD)

1. |Insert the 2.5-inch solid state drive (SSD), self-encrypting drive (SED), or solid state hybrid drive
(SSHD) into the 2.5-inch drive adapter (1). Be sure that the connector is at the opening of the
adapter.

2. Fasten the four screws (2) to secure the 2.5-inch solid state drive (SSD), self-encrypting drive (SED),
or solid state hybrid drive (SSHD) in the 2.5-inch drive adapter.

3. Slide the 2.5-inch drive adapter into the hard drive cage (1).

4. Screw the four mounting screws with grommets through the sides of the hard drive cage into the
2.5-inch drive adapter (2). Be sure to keep the blue rubber grommets behind each screw.

5. With the 2.5-inch drive connector facing toward the center of the chassis, place the drive cage
into the chassis and slide it toward the center until it snaps into place (1).
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6. Tighten the captive screw (2) to secure the hard drive cage in the chassis.

Replacing the optical disc drive

The optical disc drive is located above the hard drive on the left side of the computer (when viewed

from behind).

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

The optical disc drive can now be seen in the upper left side of the chassis.

3. Lloosen the captive screw (1) through the optical disc drive bracket that secures the optical disc
drive to the chassis.

2% NOTE: The optical disc drive bracket is installed on the chassis if the model does not have an
optical disc drive. Remove the bracket from the chassis and follow the remaining steps using two
screws from the option kit to mount the bracket to the optical disc drive.
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4. Slide the optical disc drive left (2) to remove it from the chassis.

5.
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6. Attach the optical disc drive bracket to the new optical disc drive by screwing the two screws
through the bracket into the new drive.

7. Place the new optical disc drive into the chassis and push the drive in firmly until it snaps into
place (1).

@NOTE: The optical disc drive can be installed in only one way.

8. Tighten the captive screw (2) through the optical disc drive bracket to secure the drive to the
chassis.

Replacing drives
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Webcam module

Description Spare part number

Webcam module 763215-001

On products that ship with a webcam module, the module is located at the top of the computer. It is
secured with two Phillips screws and has one connector.

The webcam module is optional.

To remove the webcam module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).
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3. Remove the two Torx screws that secure the webcam module to the computer.

By ).

4. Rotate the assembly to gain access to the connector on the module, and then disconnect the cable
from the module.

2»NOTE: To avoid damaging the connector when disconnecting the cable, be sure to pull the
cable straight out of the connector at a vertical (90°) angle.

To install @ webcam module, reverse the removal procedures.

Webcam module
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Speakers

Description Spare part number

Speakers 763212-001

Speakers are located at the bottom of the computer. Two separate speakers are each secured by two
Torx screws.

To remove the speakers:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove four Torx screw that secure the speakers to the computer (1).

B owON

Remove the speaker wires from the clips built into the computer (2).
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5. Disconnect the speaker cable from the system board connector.

T

6. Remove the speakers from the computer.

To install the speakers, reverse the removal procedures.
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Antenna

Description Spare part number

Antennas 763125-001

The antennas route from the WLAN card to the top of the computer.
To remove the antenna:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

2

3. Disconnect the antennas from the WLAN module (1).

4. Remove the antenna cables from the clips built in the computer (2).
5

Peel the main transceiver (3) and the 2nd transceiver (4) to disengage the adhesive that secure
the transceivers to the computer.

To install the antenna, reverse the removal procedures.
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Bottom stand

The bottom stand is secured to the bottom of the computer by six Torx screws.

TR

To remove the bottom stand:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

3. Remove the three screws that secure the left side of the stand to computer.

Bottom stand 53



4. Remove the three screws that secure the right side of the stand to computer.

[ =

5. Remove the stand.

Reverse the removal procedures to replace the bottom stand.
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Front bezel

Description Spare part number
Front bezel for use in models with a webcam 764958-001
Front bezel for use in models without a webcam 764959-001

The front bezel is located on the front of the computer and is secured to the main system bracket with
seven Torx screws. You can separate the bezel from the computer with most of the computer
assembled. You have to remove the rear cover, webcam, and bottom stand to remove the front bezel
from the computer.

To remove the front bezel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the webcam (see Webcam module on page 48).

0

Remove the bottom stand (see Bottom stand on page 53).

aua ~r O N

. Remove the seven Torx screws that secure the bezel to the main system bracket assembly.
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6. Lift the computer from the bezel.

To install the front bezel, reverse the removal procedures.
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Power button board

Description Spare part number

Power button board (includes insulator) 764962-001

The power button board is located on the top left side of the computer (when viewed from behind). It is
secured o a removable bracket that is connected to the computer with one Torx screw. The board has
one connector and is secured to the bracket with two Phillips screws.

To remove the power button board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

. Remove the rear cover (see Rear cover on page 34).

Remove the bottom stand (see Bottom stand on page 53).

2
3. Remove the webcam (see Webcam module on page 48).
4
5

. Remove the front bezel (see Front bezel on page 55).
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6. Disconnect the cable from the power button board (1), and then remove the Torx screw (2) that
secures the bracket to the computer.

7. To remove the board from the bracket, remove the two Phillips screws that secure the board to the
bracket.

8. Remove the power button board from the bracket.

To install the power button board, reverse the removal procedures.

Power button board
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Touch controller board

The display panel kit includes the touch controller board. The touch controller board is located on the
left side of the computer (viewed from behind) under the main rear cover above the converter board. It
is secured with two Torx screws and has two connectors.

For information about removing the touch controller board, see Display panel on page 82.

i IMPORTANT: Touch sensor boards are spared with the touch panel spare part kit. Be sure to
replace the touch sensor board when replacing a touch display panel. Failure to use the board
supplied in the kit could cause the touch module to function incorrectly.
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Converter board

Description Spare part number

Converter board 763205-001

The converter board is located on the left side of the computer (viewed from behind) under the main
rear cover, below the touch sensor board. It is secured with two Torx screws and has two connectors.

Use the same converter spare part for all display panels; however, you must change jumper settings on
the board based on the display panel.

To remove the converter board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

3. Disconnect the two cables from the board (1).

2»NOTE: To avoid damaging the connector when disconnecting the cable, be sure to pull the
cable straight out of the connector at a vertical (90°) angle.
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4. Remove the two black Torx screws (2) that secure the board to the computer.

Note the converter board jumper settings printed on the board. Be sure to correctly position the
jumpers on the converter board for the installed display panel.

5. Lift the converter board from the computer.

Be sure to correctly position the jumpers on the converter board for the installed display panel.
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/\ CAUTION:

Incorrect jumper placement can result in damage to the converter board and display
panel.

e  BOE panel: pins (1)(2)
e LG panel: pins (3)(4)

To install the converter board, reverse the removal procedures.
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VESA panel

The VESA panel is located under the stand.

To remove the VESA panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

3. Remove the three screws securing the VESA panel to the chassis (1), and then lift the panel out of
the chassis (2).

To replace the VESA panel, reverse the removal procedures.
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System board shield

The system board shield is located on the right side of the computer (when viewed from behind).

To remove the system board shield:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the VESA panel (see VESA panel on page 61).

IO

Remove the two Torx screws securing the system board shield to the chassis (1).
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5. Rotate the shield to the right (2), and then lift it off the chassis (3).

\)\“‘“\t '

To replace the system board shield, reverse the removal procedures.
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Memory

Description Spare part number
Memory module, 8-GB 689374-001
Memory module, 4-GB 689373-001
Memory module, 2-GB 689372-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) small outline dual inline memory modules (SODIMMs).

SODIMMs

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 16 GB of memory.

DDR3-SDRAM SODIMMs

For proper system operation, the SODIMMs must be:

e industry-standard 204-pin

e unbuffered non-ECC PC3-10600 DDR3-1600 MHz-compliant

e 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

e support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

e  contfain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification
In addition, the computer supports:

e  1-Gbit, 2-Gbit, and 4-Gbit non-ECC memory technologies

e single-sided and double-sided SODIMMS

e SODIMMs constructed with x8 and x16 SDRAMs; SODIMMs constructed with x4 SDRAMs are not
supported

@NOTE: The system will not operate properly if you install unsupported SODIMM memory.

HP offers upgrade memory for this computer and advises that the consumer purchase it to avoid
compatibility issues with unsupported third-party memory.
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Populating SODIMM sockets

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed. Refer to the following table to identify the SODIMM

channel locations.

Location System board label Channel
Lower Socket SODIMM1 Channel A
Upper Socket SODIMM3 Channel B

e  The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

e  The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to channel A.

e  The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

e In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.

Installing SODIMMs

There are two memory sockets on the system board. To remove or install memory modules:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

2. Remove the rear cover (see Rear cover on page 34).

3. Remove the VESA panel (see VESA panel on page 61).
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4. Remove the system board shield (see System board shield on page 62).

The memory modules can now be seen in the right side of the chassis.

5. To remove a memory module, press outward on the two latches on each side of the SODIMM (1),
then pull the SODIMM out of the socket (2).
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6. To install a memory module, slide the SODIMM into the socket at approximately a 30° angle (1),
then press the SODIMM down (2) so that the latches lock it in place.

%’NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

7. Reassemble the computer.
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Battery

The battery is located on the system board on the left side of the memory modules. The battery that
comes with the computer provides power to the realtime clock. When replacing the battery, use a
battery equivalent to the battery originally installed in the computer. The computer comes with a 3-volt
lithium coin cell battery.

/\ WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60 °C (140 °F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/\ CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a
grounded metal object.

2»NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com
recycle.

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

2,
3. Remove the VESA panel (see VESA panel on page 61).
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4. Remove the system board shield (see System board shield on page 62).

The battery can now be seen on the left side of the memory modules.

5. To release the battery from its holder, insert a thin metal instrument into the slot on the side of the
holder below the battery (1) and pry the battery up and out of the holder (2).

6. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the
positive side up (1) and press the other edge down into the holder so that it snaps in place (2).

7. Reassemble the computer.

8. Reset the date and time, your passwords, and any special system setups using Computer Setup.
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Fan

Description Spare part number

Fan 763214-001

The fan is located near the middle of the computer and is secured with three Torx screws. You do not
have to remove the heat sink to remove the fan.

To remove the fan assembly:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the system board shield (see System board shield on page 62).

2
3. Remove the VESA panel (see VESA panel on page 61).
4
5

. Disconnect the fan cable from the system board connector labeled CHFAN (1).

2 NOTE: To avoid damaging the connector when disconnecting the cable, be sure to pull the
cable straight out of the connector at a vertical (?0°) angle.

6. Remove the three Torx screws that secure the fan to the computer (2).
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7. Remove the fan from the computer (3).

To install the fan assembly, reverse the removal procedures.

2 NOTE: To avoid damaging the rubber screw grommets installed around the captive screws, when
installing the fan, push down on the fan assembly before you tighten the screws. Make sure the
grommets are positioned correctly before tightening the screws.

Fan



Heat sink

Description Spare part number

Heat sink 763213-001

The heat sink is located near the middle of the computer and is secured with four captive Torx screws
and one non-captive Torx screw. You do not have to remove the heat sink to remove the fan.

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

. Remove the rear cover (see Rear cover on page 34).

2

3. Remove the VESA panel (see VESA panel on page 61).

4. Remove the system board shield (see System board shield on page 62).
5

Remove the non-captive Torx screw from the end of the heat sink (T).
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6. In the order indicated on the heat sink, loosen the four captive Torx screws (2), and then lift the
heat sink out of the computer.

/\ CAUTION: Be sure the loosen the screws in the order indicated by the numbers stamped on the
heat sink.

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

To replace the heat sink, reverse the removal procedures.
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Processor

Description Spare part number
Intel Core i7 4770T processor, 2.5 GHz, 8-MB L3 cache, 45W 758446-001
Intel Core i7 4765T processor, 2.0 GHz, 8-MB L3 cache, 35W 754000-001
Intel Core i5 4670T processor, 2.3 GHz, 6-MB L3 cache, 45W 753999-001
Intel Core i5 4570T processor, 2.9 GHz, 4-MB L3 cache, 35W 753998-001
Intel Core i3 4330T processor, 3.0 GHz, 4-MB L3 cache, 35W 753995-001
Intel Core i3 4130T processor, 2.9 GHz, 3-MB L3 cache, 35W 757416-001
Intel Pentium G3420T processor, 2.7 GHz, 3-MB L3 cache, 35W 763217-001
Intel Pentium G3220T processor, 2.6 GHz, 3-MB L3 cache, 35W 763216-001
Intel Celeron G1820T processor, 2.4 GHz, 2-MB L3 cache, 35W 753994-001

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the VESA panel (see VESA panel on page 61).

Remove the system board shield (see System board shield on page 62).

Remove the heat sink (see Heat sink on page 72).

Rotate the locking lever fo its full open position (1).

N o U s LN

Raise and rotate the microprocessor retainer fo its fully open position (2).
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8. Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

[ NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://h18000.www.hp.com/support.

Processor
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WLAN module

Description Spare part number
HP WLAN 802.11 a/b/g/n + Bluetooth 4.0 697316-001
HP WLAN 802.11 a/b/g/n, 2x2 767424-001

The WLAN module is located on the upper right corner of the system board. The module is secured
with one Phillips screw and has two connected antennas.

To remove the WLAN module:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the VESA panel (see VESA panel on page 61).

Remove the system board shield (see System board shield on page 62).

Disconnect the antenna cables from the module (1).

o v R @ N

Remove the Phillips screw (2) that secures the module to the computer.
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7. Llift the module to a 45-degree angle (3), and then pull it away to remove it from the socket.

To install the WLAN module, reverse the removal procedures.

E/;’NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
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Hard drive and optical drive cables and connectors

Description Spare part number
Optical drive cable 763121-001
Hard drive cable 763122-001

The hard drive and optical drive connectors are located near the middle of the computer. Each
connector is secured with two Torx screws and has two cables that connect to the system board.

The optical drive connector cables are longer than the hard drive connector cables.

To remove the hard drive or optical drive connector:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

. Remove the rear cover (see Rear cover on page 34).

Remove the system board shield (see System board shield on page 62).

2
3. Remove the VESA panel (see VESA panel on page 61).
4
5

. Remove two Torx screws that secure the optical drive connector (1) or the hard drive connector
(3) to the computer.

6. Remove the cables from the metal clips built into the computer.

7. Disconnect the optical drive cables (2) or the hard drive cables (4) from the system board.

E”%NOTE: To avoid damaging the connector when disconnecting the cable, be sure to pull the
cable straight out of the connector at a vertical (90°) angle.
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8. Remove the connector from the computer.

To install the hard drive or optical drive connector, reverse the removal procedures.
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System board
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Description Spare part number
System board for use in models without the Windows 8 operating system 737340-001
System board for use in models with Windows 8 Standard 737340-501
System board for use in models with Windows 8 Professional 737340-601

The system board is located on the right side of the computer (when viewed from behind). It is secured
with nine Torx screws.

To remove the system board:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the VESA panel (see VESA panel on page 61).

Remove the system board shield (see System board shield on page 62).

Remove the heat sink (see Heat sink on page 72).

Remove the memory modules (see Memory on page 64).

Remove the processor (see Processor on page 74).

Remove the WLAN module (see WLAN module on page 76).
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10. Remove the nine Torx screws that secure the system board to the computer.

11. Remove the system board from the computer.
To install the system board, reverse the removal procedures.
Updating SMBIOS Information

When replacing the system board, you must reprogram the SMBIOS information on the affected
computer. Failure to reprogram the board will result in eventual failure, such as an activation failure
(need to reactivate the system) or a system recovery failure.

To update SMBIOS information in Computer Setup:
1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen.

2»NOTE: If you do not press Esc at the appropriate time, you must restart the computer and again
press Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. Go to Security > System ID’s.
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5. If necessary, press Cirl+A to initiate edit mode.

6. Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and
cannot be edited.

System ID Setup Page

Setup Field Name Comment Label
Product Name Enter the Model name/number or marketing name. Flexbuild
Serial Number Enter the Serial Number of Unit. Support
SKU Number Enter the SKU or Product Number including Localization Code. Support
Asset Tag Enter the 18-byte identifier assigned fo the computer. Support
Feature Byte Enter the Feature Byte string. The feature byte string is case sensitive. Flexbuild

The label includes spaces after every four characters. You can enter or ignore
these spaces - their only purpose is to help with data entry. There is a
character limitation of 40 bytes per line. When you reach this limit, go to the
next line fo continue data entry. BIOS ignores the spaces and lines.

If you make an error during data entry, the data will not validate, and the
computer asks you to correct your data input.

Build ID The Build ID of the unit. Flexbuild

Display panel

Description Spare part number

Display panel kit (includes touch controller board and backlight cable) 763203-001
NOTE: You MUST remove and replace all parts that come in the kit.

NOTE: Do not reuse any old parts. Return all old parts to HP for warranty processing.

Display panels are available from two different manufacturers — LE and BOE.

Display panels require a backlight cable specific to the manufacturer. Make sure you use the backlight
cable packaged with the display panel.

The display panel kit includes the touch controller board. The touch controller board is located on the
left side of the computer (viewed from behind) under the main rear cover above the converter board. It
is secured with two Torx screws and has two connectors.

@IMPORTANT: Touch sensor boards are spared with the touch panel spare part kit. Be sure to
replace the touch sensor board when replacing a touch display panel. Failure to use the board
supplied in the kit could cause the touch module to function incorrectly.

The display panel is secured to the base pan with four Torx screws.

82 Chapter 6 Removal and Replacement Procedures All-in One (AIO) Chassis



To remove the display panel:

1. Prepare the computer for disassembly (see Preparing to disassemble the computer on page 31).

Remove the rear cover (see Rear cover on page 34).

Remove the webcam (see Webcam module on page 48).

Remove the bottom stand (see Bottom stand on page 53).

)

Remove the front bezel (see Front bezel on page 55).

o U A~ W DN

. Remove the touch controller board as follows:

@NOTE: Replace the touch controller board that comes with the new display panel kit.

a. Disconnect the four cables from the board (1).

E/;’NOTE: To avoid damaging the connector when disconnecting the cable, be sure to pull the
cable straight out of the connector at a vertical (?0°) angle.

b. Remove the two black Torx screws (2) that secure the board to the computer.

c. Remove the touch sensor board from the computer.
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7. Disconnect the backlight cable from the display panel.

E%?NOTE: Replace the backlight cable with the new backlight cable that comes with the new
display panel kit.

Remove the backlight cable from the defective panel before sending the panel back to the
supplier.
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Remove the four Torx screws that secure the display panel to the frame. The screw locations for
each panel size are stamped into the metal.

Display panel screw locations:

Display panel
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9. Disconnect the display cable (1) and the ZIF connector cables (2) from the touch sensor board.

E%?NOTE: When removing and installing the display panel, note the locations that the cables route
through the main system bracket (3). You will have to reroute the cables through these routing

paths when reinstalling. See the end of this section for a detailed image of how the cables route
through the system bracket.

Pull the cable out from under the converter board.

10. Lift the display panel from the frame.

11. Remove the brackets from the display by removing the two Torx screws from each side, and then
lifting the brackets from the display.

E/?NOTE: The image below shows screws on only one side. Screw locations are similar on both
sides.

r__if!?*NOTE: You must remove and reuse the display brackets when you replace the panel.

12.

Be sure to correctly position the jumpers on the converter board for the installed display panel.
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/\ CAUTION: Incorrect jumper placement can result in damage to the converter board and display
panel.

e  BOE panel: pins (1)(2)
e LG panel: pins (3)(4)

To install a display panel, reverse the removal procedures.

E%?NOTE: You MUST remove and replace all parts that come in the kit.
r__":"‘/f’NOTE: Do not reuse any old parts. Return all old parts to HP for warranty processing.

E‘/?"NOTE: You must remove and reuse the display brackets when you replace the panel.

For reinstallation, note the proper location of the cables on the back of the display panel.

Display panel 87



When removing and installing the display panel, note the locations that the cables route through the
main system bracket. You will have to reroute the cables through these routing paths when reinstalling.

T sk
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Cable routing

Use the following image as a reference for how cables are routed in the computer.
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7 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

@IMPORTANT: A connected keyboard is required to access Computer Setup.

90

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic fests run
during a Full Boot. You can set the system to:

Q always Quick Boot (default);
Q periodically Full Boot (from every 1 to 30 days); or
Q always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.
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Using

e  Secure integrated I/O functionality, including the serial, USB, audio, or embedded NIC, so that
they cannot be used until they are unsecured.

e Enable or disable removable media boot ability.

e  Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

e Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

o  Execute selftests on a specified ATA hard drive (when supported by drive).

e Enable or disable Drivelock security (when supported by drive).

Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.
2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

E/?’NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

5. To apply and save changes, select File > Save Changes and Exit.

e If you have made changes that you do not want applied, select Ignore Changes and
Exit.

e To reset fo factory seftings or previously saved default seftings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

@NOTE: Not all settings shown in the following sections are available for all models

/\ CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup

(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.
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2% NOTE:

Computer Setup—File

configuration.

Support for specific Computer Setup options may vary depending on the hardware

Option

Description

System Information

Lists:

e  Product name

e  Manufacturer

e SKU number

e  Processor type/speed/stepping

e Installed memory size/speed, number of channels
e Integrated MAC address for embedded, enabled NIC (if applicable)
e  Chassis serial number

e  Asset tracking number

e  System Board ID

e  System Board CT Number

e  BIOS (includes family name and version)

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup

Save to Removable Media
Saves system configuration to a formatted USB flash media device.
Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default seftings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes fo system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

2»NOTE:  Support for specific Computer Setup options may vary depending on the hardware

configuration.

Option

Description

Device
Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

o Hard Disk: Size, model, firmware version, serial number, connector color, SMART.

e  CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-

ROM).
e Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

Storage Options

SATA Emulation

WARNING! SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are two supported options: IDE and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually
do not require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

Computer Setup (F10) Utilities
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Boot Order

Allows you to:

o EFl Boot Sources: Specify the order in which EFl boot sources (such as a internal hard drive,
USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included
for consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

e Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded from
or included for consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

Boot Order

NOTE: To drag a device to a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFl boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

2»NOTE:  Support for specific Computer Setup options may vary depending on the hardware

configuration.

Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle or reboot. If the user does not enter the correct power-on password, the unit will not
boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

Password prompt on F9, F11 & F12 (requires setup password to use these boot functions).
Default is enabled.

Network Server Mode. Default is disabled.

Stringent Password (enabling the stringent password disables the ability to reset the password
by moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or
the power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not
covered under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

Device Security

Allows you to set Device Available/Device Hidden (default is Device Available) for:

System audio
Network controller
NOTE: You must disable AMT before trying to hide the network controller.

SATA ports (varies by model)

USB Security

Allows you to set Enabled/Disabled (default is Enabled) for:

Front USB Ports
Rear USB Ports

Accessory USB Ports

Slot Security

Allows you to disable any PCl or PCl Express slot. Default is enabled.
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Network Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs

Allows you to set:

e  Asset tag (18-byte identifier), a property identification number assigned by the company fo the
computer.

e  Ownership tag (80-byte identifier) displayed during POST.

e Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

o  Keyboard Layout (language).

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data stored
on the disk. Master Boot Record Security may prevent unintentional or malicious changes to the
MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities. It also
allows you to recover the "last known good" MBR, should changes to the MBR be detected when
the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS
cannot prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:

e  MBR security is enabled

e A backup copy of the MBR has been previously saved

e  The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified
the MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved
MBR if you are confident that the current bootable disk's MBR has been corrupted or infected with a
virus.

System Security
(these options are
hardware dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this setfting requires turning the computer off and then back on. Default is

disabled.

Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this sefting requires turning the computer off and then
back on. Default is disabled.

Button Retask Password Protection (enable/disable) - Controls whether or not the Setup password
must be provided to WMI methods used to re-task the function of the side panel buttons.
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Drivelock Security

Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the Drivelock passwords during POST. If neither is
successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the Drivelock feature
is attached to the system.

Secure Boot
Configuration

This is a feature of Windows 8.

e legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set to disable, legacy boot options in Storage > Boot Order are not displayed.
Default is enabled.

e  Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

e  Key Management—This option lets you manage the custom key settings.

o Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

o Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you to use alternative operating systems.
Selecting HP Keys causes the computer boot using the preloaded HP-specific boot keys.
Default is HP Keys.

e  Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.

From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.
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Computer Setup—Power
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2¥»NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Option Description
OS Power e  Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
Management processor voltage and frequency when the current software load does not require the full

capabilities of the processor. Default is enabled.

e Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

e Unigue Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.
Default is disabled.

NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4
state, not the S5 state.

o SO (On) = Solid green LED.

oS3 (Stand By)= 3 blinks at THz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

oS4 (Hibernation)= 4 blinks at THz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

o S5 (Soft Off) = LED is off.

Hardware Power SATA Power Management — Enables or disables SATA bus and/or device power management.
Management Default is enabled.

S5 Maximum Power Savings — Turns off power fo all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCl Express Power Management — Sets Active State Power Management (ASPM) of the bus. ASPM
lets you set lower power modes that activate when the bus is not being used. Default is enabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

Option Heading

Power-On Options  Allows you fo set:
e  POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
o QuickBoot (default) = Do not clear memory or perform a memory fest.
o FullBoot = Memory test (count) on cold boot. Clears memory on all boots.
o Clear Memory = No memory count on cold boot. Clears memory on all boots.

o FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until Tst cold boot on or after x days. Clears memory on all boots.

e  POST messages (enable/disable). Enabling this feature will cause the system to display POST
error messages, which are error messages displayed on the monitor during the Power On Self
Test if the BIOS encounters some kind of problem while starting the PC. A POST error message
will only display on screen if the computer is capable of booting this far. If the POST detects
an error before this point, a beep code is generated instead. Default is disabled.

e  Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the
text “Press the ESC key for Startup Menu” during POST. This text does not display on
Windows 8 systems with Fast Boot support. Other text also will not display (for example,
Ownership Tag). Default is enabled.

e  Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. Default is enabled.

e  After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
o Power off—causes the computer to remain powered off when power is restored.
o Power on—causes the computer to power on automatically as soon as power is restored.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

e  POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCl cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

e  Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

e  Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

e  Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you fo set the computer
not to confirm when changes were made. Default is disabled.

e  POST Memory Manager Runtime Allocation (Enable/Disable). Default is disabled.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.
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Onboard Devices

Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.

Bus Options

Allows you to enable or disable:
e  PCl SERR# Generation. Default is enabled.

e  PCl VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options

Allows you to set:

e  Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.

e Num Lock State at Power-On (off/on). Default is off.
e Internal Speaker (does not affect external speakers). Default is enabled.

e Multi-Processor (enable/disable). Use this option to disable multi-processor support under the

OS. Default is enabled.
e  USB Charging Port (enable/disable). Default is enabled.
e  USB 3.0 BIOS Driver Support (enabled/disabled). Default is disabled.

e Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

VGA Configuration

Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.

Option ROM Launch
Policy

(Windows 8 only). Windows 8 installs as a UEFI operating system (as opposed to ‘legacy’), and
ships with the ‘Legacy Support’ setting off in the BIOS. When ‘Legacy Support' is off, the Option
ROM Launch Policies are set to ‘UEFI Only’. These policies control whether the Legacy Option ROM
or the UEFI driver is loaded for the following features:

e  PXE Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy option ROM or
the UEFI driver in the BIOS is used to provide PXE services.

e  Storage Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy option ROM
or the UEFI driver in the BIOS is used to provide RAID setup and support.

e  Video Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy VBIOS or the
UEFI driver in the BIOS is used to provide graphics setup and support.

e  NetClone Option ROMs (Legacy Only/Do Not Launch). Only available on models with the
NetClone operating system.

PCle Family
Controller

Provides information about the PCle controller, including:
e  Driver Name/Version/Release Date

e  Device Name

e PCl Slot

e  MAC Address
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Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 92 in the Computer Setup—File table.)

2»NOTE: |t is recommended that you save any modified computer configuration settings to a USB flash
media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility.
(See Computer Setup—File on page 92 in the Computer Setup—File table.)
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8 HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating
system.

Why run HP PC Hardware Diagnostics — UEFI

The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite
the support process when issues are found. The tools save time by pinpointing the component that
needs to be replaced.

e Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

e Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.

How to access and run HP PC Hardware Diagnostics
- UEFI

To access the UEFI diagnostics:
1. Restart or turn on the computer and press Esc repeatedly until the BIOS boot menu appears.

2. Press F2 or select Diagnostics (F2).
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How to access and run UEFI diagnostics

System Diagnostics
Customer Mode

ENTER - Contimue Startap

- S m————— i i o = > For more Information. please visit
Note: The key (F2 or F10) depends on the product.
After pressing F2, the BIOS sequentially searches three places for the system diagnostics:

a. First — a connected USB drive (to download the diagnostics tools to a USB drive, see the
instructions in Downloading HP PC Hardware Diagnostics to a USB device on page 103).

b. Second - the hard disk drive.

c. Third - in the BIOS, a core set of diagnostics (for memory and hard disk drive) that are
accessible only if the USB or hard disk drive versions are not detected.

Downloading HP PC Hardware Diagnostics to a USB

device

1.

N oo ow o»owN

Go to http://www.hp.com.

Click the Support & Drivers link.

Select the Drivers & Software tab.

Enter the product name in the text box and click Search.
Select your specific computer model.

Select your operating system.

In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.

-or -

Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

E’%NOTE: HP diagnostic solutions are developed to test components typically included on HP products.

They may not diagnose all third-party accessories that can be added to the system.

Downloading HP PC Hardware Diagnostics to a USB device
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Troubleshooting Without
Diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.

2»NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 157.

Safety and Comfort

/\ WARNING! Misuse of the computer or failure to establish a sate and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
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If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

Run the HP diagnostic tool.

Run the hard drive selftest in Computer Setup. Refer to Computer Setup (F10) Utility on page 90
for more information.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 157 for more information.

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and see if the computer functions
properly.
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e If you recently installed new software, uninstall the software and see if the computer functions
properly.

e Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

e  Refer to the comprehensive online technical support at http://www.hp.com/support.

e  Refer to Helpful Hints on page 105 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

e Bein front of your computer when you call.

e  Write down the computer serial number, product ID number, and monitor serial number before
calling.

e Spend time troubleshooting the problem with the service technician.
e Remove any hardware that was recently added to your system.
e Remove any software that was recently installed.

e  Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

/\ CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

E’%NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful Hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

e  Check that the computer and monitor are plugged into a working electrical outlet.

e  Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

e  Check that the computer is turned on and the green power light is on.

e  Check that the monitor is turned on and the green monitor light is on.
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Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 157 for more information.

Turn up the brightness and contrast controls of the monitor if the monitor is dim.
Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
Check all cable connections for loose connections or incorrect connections.

Woake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 129 for instructions.

Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

If the system has multiple video sources (embedded, PCI, or PCl-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

/\ CAUTION: When the computer is plugged into an AC power source, there is always voltage
applied to the system board. You must disconnect the power cord from the power source before
opening the computer to prevent system board or component damage.
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Solving General Problems

You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,

contact an authorized dealer or reseller.

/A WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet and allow the internal system components to cool

before touching.

Table 9-1 Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause

Solution

Software control of the power switch is not functional.

1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.

Cause

Solution

RTC (realtime clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet

prolongs the life of the RTC battery.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on installing
a new battery, or contact an authorized dealer or reseller for
RTC battery replacement.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the Computer Setup settings to make sure the
infernal system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3. Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or rear cover.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock .
A key to unlock the Smart Cover Lock is not available from
HP. Keys are typically available from a hardware store.

Poor performance.

Cause

Solution

Processor is too hot.

1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the

hard drive.

Low on memory.

Add more memory.
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Table 9-1 Solving General Problems (continued)

Poor performance.

Cause Solution

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved memory  Restart the computer.
back to the system.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. Windows 7:
1. Close unnecessary applications to free up memory.
2. Add more memory.

3. Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:

In Windows 7:

a. Go to Start > All Programs > Accessories >
Run

b. Type msconfig, and then press Enter.

c.  On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

a. On the Start screen, rightclick, and then select the
All apps icon.

b. Under Windows System, click Run.
c. Typemsconfig, and then press Enter.

d. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

Some software applications, especially games, are stressful on 1. Lower the display resolution for the current application or

the graphics subsystem. consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but

LEDs continue flashing).

Cause Solution

Processor thermal protection activated: 1.
A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open the rear cover, press the power button, and see if
the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the
hard drive LED turns green, then:

1.

3.

OR

If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power supply)
is set to the appropriate voltage. Proper voltage setting
depends on your region.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on green then:

1.

2.

Check that the unit is plugged into a working AC outlet.

Open the rear cover and check that the power button
cable is properly connected to the system board.

Check that the power supply cables are properly
connected to the system board.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

If the 5V_aux light on the system board is off, then
replace the power supply.

Replace the system board.
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Solving Power Problems

Common causes and solutions for power problems are listed in the following table.

Table 9-2 Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on  Select the proper AC voltage using the selector switch.
rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Power supply will not turn on because of internal power Replace the power supply.
supply fault.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing.)

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2. Open the rear cover, press the power button, and see if
OR the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto

The heat sink is not properly attached to the processor. the system board header.

3. |If fan a plugged in and not spinning, replace it.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the
computer beeps four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Power failure (power supply is overloaded).

1.

4.

5.

If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set fo the appropriate voltage. Proper
voltage setting depends on your region.

Open the rear cover and ensure the power supply cable
is seated into the connector on the system board.

Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If the
system enters POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

Replace the power supply.

Replace the system board.

The incorrect external power supply adapter is being used on

the All-in One or USDT.

The power supply adapter must be at the correct power rating

and use the Smart ID technology before the system will power
up. Replace the power supply adapter with the HP-supplied
power supply adapter.
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Solving Hard Drive Problems

Table 9-3 Solving Hard Drive Problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. In Windows 7, click Start, click Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, rightclick on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 129 section. If the system still
does not recognize the new device, check fo see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On Options.
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Table 9-3 Solving Hard Drive Problems (continued)

Drive not found (identified).

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Perform Drive Profection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.
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Table 9-3 Solving Hard Drive Problems (continued)

Computer will not boot from hard drive.

Cause Solution
Hard Drive's “Emulation Type” is set to “None.” (some Run the Computer Setup utility and change the “Emulation
models) Type” to “Hard Disk” in the device's details under Storage >

Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error Messages
on page 157 to determine possible causes for the blinking
red and beep codes.

See the Worldwide Limited Warranty for terms and

conditions.
Computer seems to be locked up.
Cause Solution
Program in use has stopped responding to commands. 1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving Media Card Reader Problems
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Table 9-4 Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Windows.

Cause

Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some

digital cameras use the FAT (FAT16 & FAT12) format and can

not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with

Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause

Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.

Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’'s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing fo and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.

Cause

Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted

properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on
the corresponding drive icon, and then select Eject. Pull the
card out of the slot.

In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are
not recognized by the computer.

Cause Solution

The operating system needs time to recognize the device if the Wait a few seconds so that the operating system can
reader was just installed into the computer and you are recognize the reader and the available ports, and then
turning the PC on for the first time. recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserfed media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving Media Card Reader Problems 117



Solving Display Problems

If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table 9-5 Solving Display Problems

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting fo resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, select Category from the View by
list, then under Appearance and Personalization,
select Adjust screen resolution.

To access Control Panel in Windows 7, click Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2. Expand the Resolution box, and then use the sliding
control to reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and seftings.
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Blank screen and the power LED flashes Red five times, once every second, followed by a two second
pause, and the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second
pause, and the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).
3. Replace the system board.

For systems with integrated graphics, replace the system

board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second
pause, and the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with  Disable monitor energy saver feature.
energy saver features enabled.
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Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.

Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close fo the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.
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“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause

Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so that
the new settings take effect.

To enter Safe Mode in Windows 7:
1. Restart the computer.

2. Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

4. Llog on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:
1. Press the Windows logo + | to open the Seftings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options,
select Startup Settings, and then click Restart.

4. Use the function keys or number keys to select the safe
mode option you want.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.
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High pitched noise coming from inside a flat panel monitor.

Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or
unable to center the picture on the screen (flat panel monitors using an analog VGA input connection

only).

Cause Solution

Flat panel monitor's internal digital conversion circuits may be 1. Select the monitor’s Auto-Adjustment option in the
unable to correctly interpret the output synchronization of the monitor’s on-screen display menu.

graphics card.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com
support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.
Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
info a document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.

In Windows 8, on the Start screen, type ch, and then select

Character Map from the list of applications.
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Solving Audio Problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Table 9-6 Solving Audio Problems

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged info the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.
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Table 9-6 Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones info the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems

If you encounter printer problems, see the documentation that came with the printer and to the common

causes and solutions listed in the following table.

Table 9-7 Solving Printer Problems

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer selfest.
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Printer will not turn on.

Cause Solution
The cables may not be connected properly. Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty.
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Solving Keyboard and Mouse Problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table 9-8 Solving Keyboard Problems

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement,
jumpy mouse/keyboard, or no function of mouse/keyboard and external drive.

Cause

Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard USB
receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do
not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is on.

Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.
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Table 9-9 Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the  Shut down the computer using the keyboard.

computer.

Windows 7:

1. Press the Cirl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
Enter.

3.  After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:

1. Press the Windows logo + | to open the Settings charm.

2. Use the arrow keys to select Power, and then press
Enter.

3. Use the arrow keys to select Shut Down, and then
press Enter.

4. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state. Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution
Mouse roller ball or the rotating encoder shafts that make Remove roller ball cover from the bottom of the mouse and
contact with the ball are dirty. clean the internal components with a mouse cleaning kit

available from most computer stores.
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Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

/A WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet and allow the internal system components to cool

before touching.

Table 9-10 Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.
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Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1.

Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be installed
before DIMM2, and DIMM3 must be installed before
DIMM4.

Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1.

2.,

Reseat DIMMs. Power on the system.

Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be installed
before DIMM2, and DIMM3 must be installed before
DIMM4

Replace third-party memory with HP memory.

Replace the system board.
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Power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Graphics card (some models) is not seated properly or is bad,
or system board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system

board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer
beeps ten times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Bad option card.

1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see if
fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table 9-11 Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause

Solution

S5 Maximum Power Saving feature is enabled.

Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management
> S5 Maximum Power Savings.
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Table 9-11 Solving Network Problems (continued)

Wake-on-LAN feature is not functioning.

Cause

Solution

S5 Wake on LAN is disabled (some models).

Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on
LAN.

Wake-on-LAN is not enabled.

To enable Wake-on-LAN in Windows 7:

1. Select Start > Control Panel > Network and
Sharing Center.

2. Under Tasks, select Manage network
connections.

3. Click Local Area Connection.
4. Click the Properties button.
5. Click the Configure button.

6. Click the Power Management tab, then select
Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 8:

1. From the Start screen, type ¢, and then select Control
Panel from the list of applications.

2. Select Network and Sharing Center, and then click
the Ethernet link next to the connection.

3. Click the Properties button.
4. Click the Configure button.

5. Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start

screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’'s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device

Manager for driver load and the Network Connections applet

within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system

using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start

screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the

correct operating mode.
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Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion

board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the
Control Panel and configure the network controller.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen,
type ¢, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

Network controller interrupt is shared with an expansion

board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.

If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected. Ensure that the cable is securely aftached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-  Install a working, industry-standard NIC, or change the boot
standard specifications. sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems

If you encounter memory problems, some common causes and solutions are listed in the following
table.

/\ CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.
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2»NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

Table 9-12 Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMMT socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution

You have run out of memory to run the application. Check the application documentation to determine the

memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Processor Problems

If you encounter processor problems, common causes and solutions are listed in the following table.

Table 9-13 Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Mcake sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution
The current processor does not support a feature previously 1. |Install a TXT (Trusted Execution Technology) capable
enabled on this system. processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.
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Solving CD-ROM and DVD Problems
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If you encounter CD-ROM or DVD problems, see the

common causes and solutions listed in the

following table or to the documentation that came with the optional device.

Table 9-14 Solving CD-ROM and DVD Problems
System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 129 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod info the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove

the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause

Solution

Media is corrupt.

Try different media to confirm whether media is valid.

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine
the type of media being played. If the disc still does not start,
read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Solving CD-ROM and DVD Problems

139



Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.
2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB Flash Drive Problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table 9-15 Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in  Run the Computer Setup utility and enable USB ports in
Computer Setup. Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup Run the Computer Setup utility and enable booting to
utility. removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.
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The computer boots to DOS after making a bootable flash drive.

Cause Solution
Flash drive is bootable. Install the flash drive only after the operating system boots.
Flash drive is defective. Try a different flash drive.
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Solving Front Panel Component Problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1.  Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. |If possible, replace the cable.

2. Restart the computer.

The device is not working.

1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports
are set to Enabled in Security > USB Security.
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If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet seftings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)
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Unable to connect to the Internet.

Cause

Solution

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will
be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

Windows 7:
1. Select Start > Control Panel.
2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications..

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving Internet Access Problems
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Solving Software Problems

Most software problems occur as a result of the following:

e The application was not installed or configured correctly.

e  There is insufficient memory available to run the application.
e There is a conflict between applications.

e  Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 157 to determine possible causes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.

Cause

Solution

System files may be damaged.

In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system repair
disc that contains the System Recovery Options menu. If the
problem is severe enough that Startup Repair doesn't start on
its own and you can't access the System Recovery Options
menu on your computer's hard disk, you can get to the menu
and start Startup Repair by using the Windows installation
disc or a system repair disc that you created earlier.

In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.

To access Automatic Repair:
1. Press the Windows logo + | to open the Seftings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, and
then select Automatic Repair.

Windows starts Automatic Repair.

4. Select the account to use to begin Automatic Repair, and
type the password for the account.

Windows diagnoses the computer and attempts the
repair it.

“lllegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support

For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

I%NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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Restoring and recovering in Windows 7

To protect from loss or damage, back up your personal data files. Refer to the operating system or
backup utility documentation for instructions on making backup copies of your data files.

To protect the software from loss or damage, keep a backup copy of all system software, applications,
and related files stored on the hard drive.

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support. To
obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.

System Restore

If you have a problem that might be due to software that you installed on your computer, use System
Restore fo return the computer to a previous restore point. You can also set restore points manually.

E‘/?"NOTE: Always use this System Restore procedure before you use the System Recovery feature.

E’%NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To start System Restore:
1. Close all open programs.
2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:
1. Close all open programs.

2. Click the Start button, right-click Computer, click Properties, and then click System
protection.

3. Under Protection Settings, select the disk for which you want to create a restore point.

4. Click Create, and then follow the on-screen instructions.
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System Recovery

/\ WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase.

2»NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 147.

@NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

e Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 148 or System Recovery when Windows is not responding on page 149.

e  Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 149.

System Recovery when Windows is responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

@NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 150.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.
Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

Turn on the computer.

Ll S

When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, click Recovery Manager, and then click Recovery Manager. If prompted,
click Yes to allow the program to continue.

5. Under I need help immediately, click System Recovery.
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6. Select Yes, and then click Next. Your computer restarts.

@NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media that you have created. Insert the first disc or the USB flash drive, select Yes, and then click
Next to restart the computer. If you are using discs, insert the next disc when prompted.

7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under |
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

8. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

9. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is loading Files... message appears on the screen.

5. Under I need help immediately, click System Recovery.

6. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

7. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

8. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media

You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the recovery
image stored on your hard disk drive. This image contains the operating system and software program
files that were originally installed on your computer at the factory. You can create only one set of
recovery media for your computer, and the media can be used only with this computer. Store the
recovery media in a safe place.
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E/?’NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

=¥ NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-R
DL discs to create recovery discs.

You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.

If you are creating recovery discs, be sure fo use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).

2»NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

Creating recovery media
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To create recovery discs:

1.
2,

Close all open programs.

Click the Start button, click All Programs, click Security and Protection, and then click HP
Recovery Media Creation. If prompted, click Yes to allow the program to continue.

Click Create recovery media using blank DVD(s), and then click Next.

Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

@NOTE: You must use a flash drive with a capacity of at least 8 GB.

1.
2,

Close all open programs.
Insert the USB flash drive into a USB port on the computer.

Click the Start button, click All Programes, click Security and Protection, and then click
Recovery Media Creation.

Click Create recovery media with a USB flash drive, and then click Next.

Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
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capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.

@NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

E‘%NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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Using recovery media
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/\ CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To create recovery media, see System recovery using recovery media on page 149.

To perform a System Recovery using recovery media:

1.

If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

or

Click the Start button, and then click Shut Down.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.
Press the power button to turn on the computer.

Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select the
boot menu and press Enter. Use the arrow keys to select the location where the recovery media is
inserted (USB or DVD). Press Enter to boot from that device.

If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under | need help immediately, click Factory Reset.

If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

If you are prompted to insert the next recovery disc, do so.

When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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Backup and recovery in Windows 8

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media, or create system restore points. In case of
system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

2 NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

E‘%NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media is used to start up (boot) the computer and repair the
operating system in case of system instability or failure. Your initial and subsequent backups allow you
to restore your data and settings if a failure occurs.

Type backup on the Start screen, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive, or a network drive.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e  Back up templates that are stored in their associated programs.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

|'1_':{"'4‘>NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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E/?’NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create system

repair media.

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

e {11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

@NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created, you must purchase Windows 8 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 8 operating
system media (purchased separately) on page 155.

Using the Windows recovery tools
To recover information you previously backed up:
A From the Start screen, type h, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For
additional information go to Help and Support. From the Start screen, type h, and then select Help
and Support.

1. |If possible, back up all personal files.

2. |If possible, check for the presence of the HP Recovery partition and the Windows partition:
From the Start screen, type e, and then click Windows Explorer.
—or—

From the Start screen, type c, and then select Computer.

E’/{’NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system media and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 155.
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3. If the Windows partition and the HP Recovery partition are listed, restart the computer after
Windows has loaded, and then press and hold Shift while clicking Restart.

2»NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to
the Windows Recovery Environment by default.

4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

2 NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.

Using f11 recovery tools

/\ CAUTION: Using {11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C, and
then select Computer.

@NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media, and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system media
(purchased separately) on page 155.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the company
logo is displayed. The computer Startup Menu displays.

4. Press {11 to select the System Recovery option.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order Windows 8 operating system media, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the media by calling support.

/\ CAUTION: Using Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using Windows 8 operating system media:
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E/?’NOTE: This process takes several minutes.

1. |If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

3.  When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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11

POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and
non-error text messages. If a POST error occurs, the screen will display the error message. To manually
switch to the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12).
The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
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POST Numeric Codes and Text Messages

This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

I%NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table 11-1 Numeric Codes and Text Messages

Control panel message

Description

Recommended action

101-Option ROM Checksum Error

System ROM checksum.

1. Verify the correct ROM.
2. Flash the ROM if needed.

3. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 169.)

4. Replace the system board.

103-System Board Failure

DMA or timers.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 169.)

2. Replace the system board.

162-System Options Not Set

Configuration incorrect.

RTC (realtime clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.

163-Time & Date Not Set

Invalid time or date in configuration memory.

RTC (realtime clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

164-MemorySize Error

Memory configuration incorrect.

1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3.  If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error

RAM failure.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists affer replacing
memory modules, replace the system

board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error

1/O board keyboard controller.

1. Reconnect keyboard with computer
turned off.

2. Replace the system board.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

304-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card (if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 169.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected

Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.
2. Reseat fan cable.

3. Replace front chassis fan.

514-CPU or Chassis Fan not Detected

CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.
2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected

Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.
2. Reseat fan cable.

3. Replace power supply fan.

660-Display cache is detected unreliable

Integrated graphics controller display cache

is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

917-Front Audio Not Connected

Front audio connector has been detached or
unseated from motherboard.

Reconnect or replace front audio cable.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

1151-Serial Port A Address Conflict Detected

Both external and internal serial ports are
assigned to COMT.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 169.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict Detected

Both external and internal serial ports are
assigned to COM2.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 169.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected

Both external and internal serial ports are
assigned to same IRQ.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 169.)

2. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System test
under F2 Diagnostics..

2. Apply hard drive firmware patch
if applicable. (Available at

http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA O and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options >
SATA Emulation to IDE, and select File >
Save Changes and Exit. Reenter
Computer Setup and select Security >
Drivelock Security. For each listed
Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change
Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the computer,
restore the original memory
configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2203-Setup error during MEBx execution

MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. | the error persists, replace the system

board.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2204-Inventory error during MEBx execution

BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version.

3.  If the error still persists, replace the
system board.

2205-Interface error during MEBx execution

MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. |If the error persists, update to the latest

BIOS version.

3. If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMMT1 or XMMT1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file

properly.

1. Try a different USB key device for
provisioning.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2217-ME Firmware Version request failure

ME firmware is not properly responding to
BIOS query for version information.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2218-ME Firmware Version should be
updated

ME firmware must be updated to match
current functionality contained in the system

BIOS.

1. Update to the latest ME firmware
version.

2. |If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3. If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

1. Recreate the provisioning file using third
party management console software.

2. |f the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key is
not a valid version for the current ME
firmware.

1. Reboot the computer.

2. |If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.  If the error still persists, replace the
system board.

2230-General error during MEBx execution

Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2231-ME error during MEBx execution

Error occurred during MEBx execution which
fails into “ME” grouping.

1. Reboot the computer.

2. |f the error persists, update to the latest
BIOS version and ME firmware version.

3. |If the error still persists, replace the
system board.

2232-AMT error during MEBx execution

Error occurred during MEBx execution which
fails into “AMT” grouping.

1. Reboot the computer.

2. |f the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2233-HECI error during MEBx execution

Error occurred during MEBx execution which

fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  |If the error still persists, replace the
system board.

2239-ME image lock failure

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1. Reboot the computer.

2. |f the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2240-ME image unlock failure

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.
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Table 11-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

Invalid Electronic Serial Number

Electronic serial number is missing.

Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1.

4.

Reconnect keyboard with computer
turned off.

Check connector for bent or missing
pins.

Ensure that none of the keys are
depressed.

Replace keyboard.

Parity Check 2

Parity RAM failure.

Run Computer Setup and Diagnostic utilities.
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Interpreting POST diagnostic front panel LEDs
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@NOTE:

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool

before touching.

If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the

computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Table 11-2 Diagnostic front panel LEDs and audible codes

Activity Beeps Possible Cause Recommended Action
Green Power LED On. None Computer on. None
Green Power LED flashes every None Computer in Suspend to None required. Press any key or move the mouse
two seconds. RAM mode (some models  to wake the computer.
only) or normal Suspend
mode.
Red Power LED flashes two 2 Processor thermal 1. Ensure that the computer air vents are not
times, once every second, protection activated: blocked and the processor cooling fan is
followed by a two second running.
pause. Beeps stop after fifth A fan may be blocked or
iteration but LEDs confinue until not turning. 2. Open hood, press power button, and see if
problem is solved. the processor fan spins. If the processor fan
OR is not spinning, make sure the fan's cable is
plugged onto the system board header.
The heat sink/fan
assembly is not properly 3. If fan is plugged in, but is not spinning, then
attached to the processor. replace heat sink/fan assembly.
4. Contact an authorized reseller or service
provider.
Red Power LED flashes three 3 Processor not installed (not 1. Check to see that the processor is present.

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

an indicator of bad
processor).

2. Reseat the processor.

Chapter 11
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Table 11-2 Diagnostic front panel LEDs and audible codes (continued)

Activity Beeps Possible Cause Recommended Action
Red Power LED flashes four 4 Power failure (power 1. Open the hood and ensure the 4 or 6-wire
times, once every second, supply is overloaded). power supply cable is seated into the
followed by a two second connector on the system board.
pause. Beeps stop after fifth
iteration but LEDs continue until 2. Check if a device is causing the problem by
problem is solved. removing ALL attached devices. Power on
the system. If the system enters the POST,
then power off and replace one device at a
time and repeat this procedure until failure
occurs. Replace the device that is causing
the failure. Continue adding devices one at
a time to ensure all devices are functioning
properly.
3. Replace the power supply.
4. Replace the system board.
Red Power LED flashes five 5 Pre-video memory error. CAUTION: To avoid damage fo the DIMMs or
times, once every second, the system board, you must unplug the computer
followed by a two second power cord before attempting to reseat, install, or
pause. Beeps stop after fifth remove a DIMM module.
iteration but LEDs continue until
problem is solved. 1. Reseat DIMMs.
2. Replace DIMMs one at a time to isolate the
faulty module.
3. Replace third-party memory with HP
memory.
4. Replace the system board.
Red Power LED flashes six 6 Pre-video graphics error.  For systems with a graphics card:
times, once every second,
followed by a two second 1. Reseat the graphics card.
pause. Beeps stop affer fifth | : " 4
iteration but LEDs continue until 2. Replace the graphics card.
problem is solved. 3. Replace the system board.
For systems with integrated graphics, replace the
system board.
Red Power LED flashes seven 7 System board failure Replace the system board.
times, once every second, (ROM detected failure
followed by a two second prior to video).
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.
Red Power LED flashes eight 8 Invalid ROM based on 1. Reflash the system ROM with the latest BIOS

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

bad checksum.

image. See the “Boot Block Emergency
Recovery Mode” section of the Desktop
Management Guide for more information.

2. Replace the system board.
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Table 11-2 Diagnostic front panel LEDs and audible codes (continued)

Activity Beeps Possible Cause Recommended Action
Red Power LED flashes nine 9 System powers on but is 1. Unplug the AC power cord from the
times, once every second, unable to boot. computer, wait 30 seconds, then plug the
followed by a two second power cord back in to the computer.
pause. Beeps stop after fifth
iteration but LEDs continue until 2. Replace the system board.
problem is solved.
3. Replace the processor.
Red Power LED flashes eleven 11 The current processor does 1. Install a TXT capable processor.
times, once every second, not support a feature
followed by a two second previously enabled on this 2. Disable TXT in the Computer Setup (F10)
pause. Beeps stop after fifth system. utility.
iteration but LEDs continue until ) o
problem is solved. 3. Reinstall the original processor.
Red Power LED flashes eleven 12 MXM thermal shutdown. 1. Clean the MXM graphics card heat sink.
times, once every second,
followed by a two second 2. Replace the MXM graphics card heat sink.
pause. Beeps stop after fifth _
iteration but LEDs continue until 3. Replace the MXM graphic card.
problem is solved.
System does not power on and None System unable to power Press and hold the power button for less than 4

LEDs are not flashing.

on.

seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Replace the system board.
OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open rear cover and check that the power
button cable is properly connected to the
system board.

3. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button board and
cable. If the problem persists, replace the
system board.

4. Replace the AC adapter.
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12 Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password,
any user can access all the information on the computer except Computer Setup. When you establish
only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the setup password will
give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

/\ CAUTION:  Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 90 for information.

CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup
password or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password
or power-on password in a safe place away from your computer. Without these passwords, the
computer cannot be unlocked.
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Establishing a Setup or Power-on password

To establish the power-on or setup password features, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

3. Press the F10 key to enter Computer Setup.
4. To establish Setup password, select Security > Setup Password and follow the instructions.

To establish a Power-On password, select Security > Power-On Password and follow the
instructions on the screen

5. Before exiting, click File > Save Changes and Exit.
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Resetting the Setup and Power-on password

To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

/\ WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3. Remove the rear cover.

4. Llocate the header and jumper labeled PSWD.

@NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the lllustrated Parts & Service Map
(IPSM). The IPSM can be downloaded from http://www.hp.com/support.

Remove the jumper.
Replace the jumper.
Replace the rear cover.

Reconnect the external equipment.

0 ® N oW

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

10. Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 90 for
information.
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Clearing and resetting the CMOS

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Cirl+P during
POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

/\ WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage fo the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or rear cover.

/\ CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important
to back up the computer CMOS settings before resetting them in case they are needed later. Back
up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 90 for
information on backing up the CMOS settings.
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4. locate, press, and hold the CMOS button in for five seconds.

2% NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure 12-1 CMOS button

2»NOTE: For assistance locating the CMOS button and other system board components, see the
llustrated Parts & Service Map (IPSM).

5. Replace the computer cover or rear cover.
6. Reconnect the external devices.

7. Plug in the computer and turn on power.

2»NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you
that configuration changes have occurred. Use Computer Setup to reset any special system setups
along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 90.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sefs for use in other countries must meet the requirements of the country where you use the
computer.

General requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

/\ WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements

For use in Japan, use only the power cord received with this product.

/\ CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW ltaly (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) uL

Germany (1) VDE

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B Statement of Volatility

HP confirms that Intel-based business desktop HP ProOne 400 G1 AIO Business PC (21.5” Touch)
desktop systems contain DDR3 volatile memory (memory amount depends on the customer
configuration). In addition, the motherboard in the condition originally shipped without subsequent
modification or the addition or installation of any applications, features, or functionality, contain the
following nonvolatile memory: Real Time Clock battery backed-up configuration memory (256 Bytes),
DIMM Serial Presence Detect (SPD) configuration data (256 Bytes per module, 128 Bytes

programmable), Serial Peripheral Interface (SPI) ROM for System BIOS (8M Bytes) and Super I/O's:
masked keyboard ROM (overall 2K Bytes).. The volatile memory will not hold any user data once
power has been removed for 30 seconds or longer.

Please find below a list of steps that should be taken to restore the Non Volatile memory found in the
Intel-based HP ProOne 400 G1 AIO Business PC (21.5" Touch) systems.

1. Download the latest BIOS for this system and operating system off of the HP website.
2. Follow the instructions on the website to flash the BIOS.

3. Shut down Windows, and then turn on the computer and enter the Computer Setup Utility by
pressing the esc key when the “Press the ESC key for Startup Menu” prompt appears near the
bottom of the screen (before the operating system loads). Choose Computer Setup (F10) from
the list of options.

4. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System IDs.
5. Select File > Save Changes and Exit.

6. To clear the Setup or Power-On passwords and any other settings, power down the computer and
remove the access panel.

7. On the system board, locate the black, two-pin password jumper on header E49 (labeled PSWD)
and remove it.

8. Disconnect the power cord, and then wait 10 seconds to let AC power drain out of the computer.

9. Remove the CMOS battery, and then press the clear CMOS button (typically a yellow push button
(labeled CMOS) on the system board).

10. Replace the CMOS battery, power cord, and access panel. The passwords are now cleared and
all other user-configurable, non-volatile memory settings are reset to their factory default values.

11. Turn on the computer and enter the Computer Setup Utility.
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12. Select File > Default Setup > Restore Factory Settings as Default. This action resets
settings back to their factory defaults.

13. Select File > Apply Defaults and Exit.

14. Shut down the computer, remove the power cord, remove the access panel, and then replace the
black jumper onto header E49. Replace the access panel and power cord.

If Computrace is enabled on the computer, see the service provider for instruction to disable the feature.

The Real Time Clock (RTC) battery backed-up configuration memory can also be cleared by removing
the power cord and then removing the coin cell battery located on the system board.
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C Specifications
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Dimensions (with stand)

Height 15.9in 402.6 mm
Width 22.0in 557.9 mm
Depth 3.3in 84.4 mm
Dimensions (without stand)

Height 14.3 in 362.9 mm
Width 22.0in 557.9 mm
Depth 2.3in 59.4 mm
Approximate Weight

(With stand) 17.61b-17.9 lbs 7.99 kg-8.14 kg
(Without stand) 16.41b-16.7 lbs 7.42kg-7.57 kg
Temperature Range

Operating 50° to 95°F 10° to 35°C
(At sea level with an altitude derating of 1.0°C per every 1000 ft

(304.8m) above sea level to a maximum of 10,000 ft (3048m), no

direct sustained sunlight. Maximum rate of change is 10°C/Hr. The

upper limit may be limited by the type and number of options

installed.)

Storage -22° to 140°F -30° to 60°C
(Maximum rate of change: 20°C/Hr.)

Relative Humidity (non-condensing)

Operating 10-90% 10-90%
(Relative humidity (Rh), 28°C maximum wet bulb temperature, non-

condensing.)

Storage 595% 595%

(Relative humidity (Rh), 38.7°C maximum wet bulb temperature,
non-condensing.)

Appendix C  Specifications



Maximum Altitude (unpressurized)

Operating 0-10,000 ft 0-3,048 m
(This value may be limited by the type and number of options
installed. Maximum allowable altitude change rate is 1500 ft/min
(457m/min)).
0-30,000 ft 0-9,144 m
Non-operating
(Maximum allowable altitude change rate is 1500 ft/min (457m/
min).)
Power Supply
Rated Voltage Range 100-240 V
Rated Line Frequency 50-60 Hz
Max Operating Power 120 W

179



Index

A
adjusting
audio 8
brightness 8
anfenna

removing 52
antenna kit, spare part number
18, 20
antennas
spare part number 52
audible codes 166
audio problems 123
audio, adjusting 8

B
backlight cable, spare part
number 18

Backup and Restore 153
battery

disposal 29
battery, replacing 68
booting options

Full Boot 157
bottom stand, removing 53
brightness, adjusting 8

C

cable lock, spare part number
cable management 30

cable pinouts, SATA data 30
cable routing 89

card reader, spare part number

15, 21

cautions
AC power 22
cables 28

electrostatic discharge 22
keyboard cleaning 27
keyboard keys 27
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CD-ROM or DVD problems 138
chasis types, illustrated 22
cleaning

computer 26

mouse 27

safety precautions 26
CMOS

backingup 169

clearing and resetting 172
components

front 3

rear 5

side 4
computer cleaning 26
converter board

removing 59

spare part number 16, 21, 59
converter board cable, spare part

number 18, 20
country power cord set
requirements 175

Customer Support 104, 146

D
display
adjusting audio 8
adjusting brightness 8
display cable, spare part number
18, 20
display panel
removing 82
spare part number 14, 21, 82
DisplayPprt cable, spare part
number 18
drive
2.5-inch, installing 44
2.5-inch, removing 41
3.5-inch, installing 43

3.5-inch, removing 38
types 38

E
electrostatic discharge (ESD) 22
preventing damage 23
error
codes 157, 166

messages 158

F
f11 recovery 155
fan
removing 70
spare part number 15
features
overview 1
flash drive problems 140
flashing LEDs 166
foot covers, spare part number
15, 21
front bezel
removing 55
spare part number 13, 21, 55
front components 3
front panel problems 142

G
general problems 107
grounding methods 24

H

hard drive
2.5-inch 38
2.5-inch, installing 44
2.5-inch, removing 41
3.5-inch 38
3.5-inch, installing 43
3.5-inch, removing 38



proper handling 28
replacing 38
SATA characteristics 29
self-encrypting drive (SED) 38
solid state drive (SSD) 38
solid state hybrid drive
(SSHD) 38
types 38
hard drive cable
spare part number 20, 78
hard drive cable, spare part
number 18
hard drive connector
removing 78
spare part number 15
hard drive problems 113
hard drive recovery 155
hardware installation problems
129
heat sink
removing 72
spare part number
helpful hints 105

15,72

I
installing
2.5-inch hard drive 44
2.5-inch self-encrypting drive
(SED) 44
2.5-inch solid state drive
(SSD) 44
2.5-inch solid state hybrid drive
(SSHD) 44
3.5-inch hard drive 43
battery 68
memory 65
optical disc drive 45
rear cover security screw 32
Internet access problems 142

K
keyboard
cleaning 26
synchronizing wireless 33
keyboard problems 127
keyboards
spare part number 17

L
LEDs

blinking power 166

blinking PS/2 keyboard 166
lower panel

removing 62

LVDS cable, spare part number
18, 20

M
Media Card Reader problems
116
memory
installing 65
removing 65
SODIMMs specifications 64
specifications 64
memory modules
spare part number 14
memory problems 135
monitor problems 118
mouse
cleaning 27
spare part number 15
synchronizing wireless 33
mouse problems 127

N
network problems 131
numeric error codes 158

o
opening the computer 31
operating guidelines 25
optical disc drive

replacing 45
optical drive

spare part numbers 19
optical drive cable

spare part number 20, 78
optical drive cable, spare part

number 18

optical drive connector

removing 78

spare part number 15
optical drive problems 138
overheating, prevention 25

P
password
clearing 169

poweron 169
setup 169
POST error messages 157
power button board
spare part number 16, 21, 56

power button board cable, spare
part number 18, 20

power cord set requirements

country specific 175
power problems 111
power supply 179

spare part number 14
power-on password 169
printer problems 125
problems

audio 123

CDROM or DVD 138

flash drive 140

front panel 142

general 107

hard drive 113

hardware installation 129

Internet access 142

keyboard 127

Media Card Reader 116

memory 135

monitor 118

mouse 127

network 131

power 111

printer 125

processor 137

software 144
processor

spare part number 14
processor problems 137
product ID locations 7

R
rear components 5
rear cover
removing 34
spare part number
rear cover, locked 108
recovery partition 155
removal and replacement
procedures
All-in One chassis 31
antenna 52
cable routing 89

Index

13, 21, 34
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converter board 59
display panel 82
fan 70
front bezel 55
hard drive connector 78
heat sink 72
optical drive connector 78
power button board 56
preparing to disassemble the
computer 31
rear cover 34
speakers 50
system board 80
system board shield 62
thermal module 72
touch controller board 83
VESA panel 61
webcam module 48
WLAN module 76
removing
2.5-inch hard drive 41
2.5-inch self-encrypting drive
(SED) 41
2.5-inch solid state drive
(SSD) 41
2.5-inch solid state hybrid drive
(SSHD) 41
3.5-inch hard drive 38
battery 68
bottom stand 53
stand 35
resetting
CMOS 169
password jumper 169
restoring the hard drive 155

S
safety and comfort 104
safety precautions
cleaning 26
SATA
connectors on system board
29
data cable pinouts 30
hard drive characteristics 29
screws, correct size 28
security
rear cover security screw
location 32
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self-encrypting drive (SED)

2.5-inch, installing 44

2.5-inch, removing 41
serial number locations 7
service considerations 27
setup password 169
side components 4
SODIMM

identification 65

location 65

specifications 64
software

problems 144

servicing computer 27
solid state drive (SSD)

2.5-inch, installing 44

2.5-inch, removing 41
solid state hybrid drive (SSHD)

2.5-inch, installing 44

2.5-inch, removing 41
spare part number

tamper-resistant wrench 28

Torx T-15 screwdriver 27
speaker

spare part number 15, 21
speakers

removing 50

spare part number 50
specifications

computer 178
specifications, memory 64
stand

spare part number 14, 21, 35

stand, removing 35

Statement of Volatility (SOV) 176

static electricity 23
swivel adjustment 6

synchronizing wireless keyboard

and mouse 33
system board
removing 80
SATA connectors 29
spare part number 14, 80
system board,
spare part number 20

T

tamper-proof screws
tool 28

temperature control 25

thermal module
removing 72
tilt adjustment 6
tools, servicing 27
Torx T15 screwdriver 27
touch control cable, spare part
number 18, 20
touch controller board
removing 83
touch sensor board
spare part number 16

v
ventilation, proper 25
VESA panel

removing 61

w
Wake-on-LAN feature 131
webcam
spare part number 16, 21
webcam cable, spare part
number 18, 20
webcam module
removing 48
spare part number 48
Windows 8 operating system
DVD 155
WLAN module
removing 76
spare part number 76
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